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There were nine Quick Base product releases in 2012: 

 
Date Highlights 
January 22nd

 Mobile web version of QuickBase 

February 26th  Improved UI for app settings tabs 

March 11th  Improved UI for My QuickBase page, improved UI for configuring roles 

April 22nd  Ability to add and edit records on mobile version 

May 20th  Improved UI for” app settings, roles, My QuickBase pages 

June 10th  

Search, scroll, and email improvements for mobile, confirmation step added 

to the “delete app” process 

September 30th  New user interface (UXv2, codenamed “Mango”) 

November 18th  Default roles, report builder improvements 

December 9th  Email management improvements, billing history visibility 

 

 

 



January 2012 Release Notes [return to top] 

In our January 22 release, we have added several features to QuickBase. See the sections below for 

further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The January 22 release introduces the following new features: 

• Mobile Web Version of QuickBase 

• Hide "Test as role" Feature for Roles 

• Personal Report Subscriptions 

 

Mobile Web Version of QuickBase 

Mobile QuickBase is a mobile-friendly version of the QuickBase website that displays automatically when 

you open QuickBase in your mobile browser. Use the mobile site on your smartphone or tablet to view 

your applications on-the-go. 

We support the following mobile operating systems: 

• Apple iOS 3.1+ 

• Android 2.1+ 

For now, the mobile QuickBase site only allows viewing applications. You cannot modify applications 

within the mobile site, but you can switch quickly to the regular QuickBase site (called the full site) in your 

http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-january-22-2012#new
http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-january-22-2012#fixed
http://quickbase.uservoice.com/
http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-january-22-2012#mobileweb
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mobile browser for tasks such as editing or adding records, creating new reports, or modifying your 

application's structure. 

Hide "Test as role" Feature for Roles 

You can now choose to hide the "Test as role" feature from the User Interface for any role.  If you hide 

the feature for a role, users in that role will no longer see the Test as role option in the Sign 

in as menu. 

Choose to show or hide the Test as role option by selecting Customize > Roles, then choosing the role 

you want to edit. In the Menus section of the User Interface tab, show or hide the Test as role option 

for that role.  

 

Personal Report Subscriptions 

As requested on UserVoice, QuickBase users and application administrators may now create report 

subscriptions for personal reports. 



 

What’s Fixed in QuickBase? 

We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 

QuickBase releases include bug fixes from previous releases.) 

Form UI Issues 

Issue Description 

QBE001877, 
QBE004605 

Under some circumstances, it was not possible to remove a field from a form. 
This issue has been resolved. 

QBE004714, 
QBE005171, 
QBE005301 

When editing a record, the "?" Help icon displayed on a new line (instead of to 
the right of the field) when the Help property was defined for a reference field 
with a conditional behavior. This issue has been resolved. 

QBE005411 Apostrophes did not display correctly for built-in fields on forms. This issue has 
been resolved. 

QBE005413 Fields on a form were vertically middle-aligned when they appeared on the 
same row in a section that had been set to show field labels above fields. This 
issue has been resolved, and the fields are now correctly top-aligned. 

QBE005675 Table headers in a record appeared above the grey overlay used when a record 
was being saved. This issue has been resolved. 

 
Grid Edit Issues 

Issue Description 

QBE001765 Conflict Resolution of edits to a proxy field in Grid Edit would not proceed after 
the user clicked Begin Conflict Resolution. This issue has been resolved. 

QBE004372 The Grid Edit conflict dialog did not display large amounts of text gracefully, and 
the button to dismiss the error message was not accessible in this case. This 
issue has been resolved. 

QBE005470 On Apple iPhones and iPads, checkbox fields could not be checked in Grid Edit. 
This issue has been resolved. 



QBE005533 When using Grid Edit on multi-line text fields, line breaks were incorrectly 
treated as editing conflicts. This issue has been resolved. 

QBE005556 When using Grid Edit on a proxy field that proxies for a text field, false editing 
conflict errors were reported. This issue has been resolved. 

QBE005579 Editing a proxy field in Grid Edit resulted in a “Look-up fields are not editable” 
message if the source field in the master table was set to view only. This issue 
has been resolved. 

 
Summary Report Issues 

Issue Description 

QBE003694 In cross-tab summary reports grouped on a Formula - Duration field, that field 
sorted as text rather than numerically. This issue has been resolved. 

QBE005425 In summary reports grouped on a Date/Time field, clicking through to view 
details of the groups did not display the individual records. This issue has been 
resolved. 

QBE005563 In crosstab summary reports, using Combine on a Numeric field resulted in the 
report sorting as text rather than numerically. This issue has been resolved. 

QBE005619 In cross-tab summary reports with row grouping by First Word, links to records 
in the row groupings did not work. This issue has been resolved. 

 
Other Issues 

Issue Description 

QBE001863 Reports with <ask the user> selection criteria for a Reference field returned no 
records if the user selected <anything>. This issue has been resolved; selecting 
<anything> now returns all records as expected. 

QBE004802 Personal reports were not copied when you copied an application.  This issue has 
been resolved; personal reports are now copied automatically when you copy an 
application. 

QBE005227 When a role was denied access to a field, and another role allowed access to 
Everyone on the Internet, setting table-level access to None in the second role did 
not successfully bar a user in the first role from accessing the field denied to him. 
The issue was resolved by adding a No Access option for fields in the Role 
Permissions tab when customizing roles. 

QBE005244 When creating an email notification in Chrome, and viewing Additional criteria, the 
checkboxes for notifying about specific field changes displayed by default, even 
though the When any field changes radio button was selected. This issue has been 
resolved. 

QBE005321 The button names on the Confirm Navigation dialog in Chrome were not consistent 
with the dialog text. The Confirm Navigation dialog displays when you have unsaved 
changes and attempt to navigate away from the current page. This issue has been 
resolved. 

QBE005334 Creating a sandbox, copying an application, and cloning an application did not retain 
the original application's current revision setting for an attachment field. This issue 
has been resolved. 



QBE005429 Calls to API_GetRecordInfo were replacing newline characters (\n) in text fields with 
<br/> tags. This issue has been resolved; those characters now appear correctly as 
"&#010;". 

QBE005430 Extremely long formulas with syntax errors caused the formula syntax error dialog to 
display incorrectly. This issue has been resolved. 

QBE005465 When entering email addresses to share an application with a new user, separating 
the email addresses by a semicolon and space caused duplicate users to appear in 
the email address field and to be created in the application. This issue has been 
resolved. 

QBE005529 When creating or editing a report, it was possible to select fields that were not 
reportable for sorting, filtering, or display. This issue has been resolved. 

QBE005558 The user status in SAML realms could be inaccurate and confusing.  This issue has 
been resolved. 

QBE005580 On forms in Safari for Windows, you could not pick <Select another user...> in a User 
dropdown.  This issue has been resolved. 

QBE005613 In Internet Explorer 7 and 8, if the Filter Criteria Builder included a date field as the 
second criteria, under certain circumstances you were unable to select a date.  This 
issue has been resolved. 

QBE005618 You were able to add duplicate fields to a form.  This issue has been resolved. 
UPDATE as of 1/31/2012: This QuickBase release has been patched to allow 
duplicate fields on a form when the field type does not allow data entry. For 
example, formulas, report links, and summary fields can now be duplicated on a 
form. 

QBE005620 Advanced Find was not defaulting to the correct table if the first table in the 
application was hidden for the role.  This issue has been resolved. 

QBE005645 The Find > Advanced Find menu option no longer appears when there are no tables 
visible. 

QBE005648 The Exact Form custom code in the online help has been updated to prevent caching 
when loading reports.  

QBE005660 The documentation did not clearly explain how sharing an application with 
"Everyone on the Internet" interacts with testing roles. This issue has been resolved. 

QBE005663 In Safari, using the keyboard to navigate QuickBase menus closed the Find menu 
prematurely. This issue has been resolved. 

QBE005664 In Firefox, selecting text or clicking in the Find field (available from the Find menu) 
using the mouse would fail. This issue has been resolved. 

QBE005666 When resetting a password, you could enter one longer than 20 characters, but the 
QuickBase login screen did not recognize the longer password. This issue has been 
resolved, and 20 characters is now the maximum length for a password. 

QBE005685 When access to applications in a QuickBase realm had been limited by IP address, 
and an API call originated from an IP address that was not allowed, QuickBase 
returned an "unknown" error. This issue has been resolved, and that error has been 
assigned error code 19 (Unknown IP address). 

QBE005695 When creating a new application, pressing Enter after typing the application name 
would cancel the action and display the My QuickBase page. This issue has been 
resolved; pressing Enter now correctly creates the application. 

QBE005700 When placeholders were replaced with user data, the changes were not being 
saved. This issue has been resolved. 



QBE005704 The Partners & Add-ons menu option was missing from the Help menu. This issue 
has been resolved. 

QBE005709 In some cases, form rules involving Duration formulas would not fire. This issue has 
been resolved. 

  



February 2012 Release Notes [return to top] 

In our February 26 QuickBase release, we improved the table customization tabs, made it easier to 

request application create permission, and added functionality to the preview of mobile QuickBase. See 

the sections below for further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The February release introduces the following new features: 

• Improvements to the Customize > Table Tabs 

• Changes to the Customize > Table Tab URLs 

• Removal of Grid Edit Settings from the Forms Tab and Report Builder 

• Quickly Request Permission to Create Applications 

• Mobile QuickBase Improvements 

• Submit Feedback on QuickBase Online Help 

Improvements to the Customize > Table Tabs 

As part of our ongoing effort to make the QuickBase UI more intuitive, we have given most of the tabs 

you use to customize your tables a makeover. We improved the look and consistency of the Fields, 

Relationships, Forms, Reports, Emails, and Properties tabs. In some cases, we changed the name of 

settings to make them easier to understand.  Access these tabs by selecting Customize > Tables from 

the menu bar on any application page.   
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Customize > Tables Field Tab before the February release 

Note: We didn't change the Permissions tab in this release. 

Learn more about changes to the: 

• Fields Tab 

• Relationships Tab 

• Forms Tab 

• Reports Tab 

• Emails Tab 

• Properties Tab 
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Fields Tab 

 

 

You'll find the following changes on the Fields tab: 

• The initial view of the Fields tab contains only the field's name and type, and whether it is a 

default column for reports. You can add other columns (Reportable, Searchable, Relationship, 

Info and Field ID) to the display using the Advanced Options link. 

• We enabled drag and drop field ordering by default. You can enable column sorting using the 

Advanced Options link. 

• We enabled multi-select for fields. Just click on the checkbox to the left of each field you want to 

select. Selected fields may be deleted or dragged to another position in the field list. 

• The Fields tab has a new toolbar that provides searching and filtering controls for the field list. 

• You can hover the mouse over the name of a field to get more information about it. 

• The field name now has an icon to show when it is a key, a default sort field, or part of a 

relationship. 

• The field label now has a field type icon to its left. 

• We added the ability to copy a field. 

• We added the ability to delete multiple fields at once by selecting each the checkbox for each field 

you want to delete and clicking the Delete button in the toolbar. 



• The Add Fields button is now called New Fields. 

• The Default Columns column is now called Default in Reports. 

• The checkboxes in the Default in Reports, Reportable, and Searchable columns have been 

replaced by checkmarks. Checkmarks in these columns can be clicked to toggle whether these 

field properties are enabled or disabled. 

• The Type column now indicates if a Text field is Multi-line or Multiple Choice, and if a Numeric 

field is a Percent, Rating, or Currency. 

• The Move to top and Add fields after this one commands have been removed. Select a field 

before clicking New Fields to add the new fields after the selected field. 

Relationships Tab 

 

 

You'll find the following changes on the Relationships tab: 

• We added a brief description for each relationship. 

• You can hover the mouse over the name of a relationship to view its reference field.  

• You now click the name of the relationship to edit it, instead of clicking an Edit link. 



Forms Tab 

 

 

You'll find the following changes on the Forms tab: 

• The Create a New Form button is now called New Form. 

• The forms are now always listed on the tab, even if there is only one form. 

• You now click the name of the form to edit it, instead of clicking an Edit link. 

• The Preview, Copy, and Delete buttons for each form have been replaced with icons. 

• The Forms Usage section has been replaced with two sections: Set how different roles use 

these forms and Override role settings by report.  You use these sections to associate forms 

with different roles and/or reports. These sections now only appear on the tab if you have more 

than one form.  (If there is only one form, it is used for all roles and reports.) 

• The Grid Edit setting for roles and reports have been removed for new users and for existing 

forms that didn't use the settings.  (If you had chosen settings other than "Standard" for a 

particular table’s form, you still see the grid edit settings on that table's Forms tab.)  Read more 

about the removal of Grid Edit form settings. 

http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-february-2012-8#grid_edit


Reports Tab 

 

You'll find the following changes on the Reports tab: 

• The Create a New Report button is now called New Report. 

• The information that used to be presented in the More Info column is now available by hovering 

the mouse over the report name. 

• The red asterisk that indicated reports not normally visible to users in your role has been replaced 

by an icon to the right of the report name. 

• The Display, Copy, and Delete buttons for each report have been replaced with icons. 

• We added the ability to delete multiple reports at once by selecting each the checkbox for each 

report you want to delete and clicking the Delete button in the toolbar. 

• We enabled multi-select for reports. Just click on the checkbox to the left of each report you want 

to select. Selected reports may be deleted. 

• The Reporting Defaults and Record Picker Defaults setting links, which used to appear as the first 

two entries in the report list, can now be accessed through the More dropdown menu. 

The changes to the Reports tab also apply to the Personal Reports page.  Access this page by 

selecting Customize > Personal Reports from the menu bar on any application page.  



Emails Tab 

 

You'll find the following changes on the Emails tab: 

• The Create a New Email button is now called New Email.  The dialog for selecting which type of 

email you want to create when you click the New Email button has been redesigned to make it 

easier to select your choice. 

• The Disable Checked and Enable Checked buttons have been replaced by an Active column. 

Checkmarks in the column can be clicked to toggle whether the email is active (enabled) or not 

active (disabled). 

• The Delete Checked button is now called Delete. 

• The Copy button for each report has been replaced with an icon. 

• Each email now has a separate Delete icon. 

• An icon now appears next to each email’s name, indicating whether it is a Subscription, 

Notification, or Reminder. 

• The information that used to be presented in the More Info column is now available by hovering 

the mouse over the email name. 

• We added the ability to delete multiple emails at once by selecting each the checkbox for each 

email you want to delete and clicking the Delete button in the toolbar. 

The changes to the Emails tab also apply to the Personal Automated Emails page.  Access this page by 

selecting Customize > Personal Automated Emails from the menu bar on any application page. 



Properties Tab 

 

You'll find the following changes on the Properties tab: 

• The Properties settings have been consolidated into a single tab containing three sections: 

• Table and Record Names  - contains basic table and record properties 

• Identifying Records - contains record picker settings and the title used for records on forms.    

• Advanced Table Settings - contains advanced properties such as including a table in search, 

showing/hiding edit buttons in reports, and showing/hiding the table name the menu bar. 

• We changed the names of several Properties settings to make them more consistent and easier to 

understand, as described in the following table: 

Previous Setting Name New Setting Name 

Include this table while searching Include this table in global searches 

Hide from Menu Bar Show in the menu bar 



Menu Heading Override Override the heading with  

Note: This setting now is only visible if Show in 

the menu bar is enabled. 

Singular Noun Override A single record is called 

Record Name Record Title 

 
Changes to the Customize > Table Tab URLs 

We changed the URLs of some the tabs you use to customize your tables so that QuickBase can display 

the contents more rapidly for applications with many tables. The Fields, Relationships, Reports, and 

Emails tabs now include the table dbid instead of the application-level dbid. For example, the URL for the 

Emails tab changed from https://www.quickbase.com/db/<application_dbid>?a=emaillist to 

https://www.quickbase.com/db/<table_dbid>?a=emaillist. 

Access these tabs by selecting Customize > Tables from the menu bar on any application page.  

Note: For now, QuickBase redirects you automatically to the new URL for the tab if you try to access the 

tab via the previous URL. In the future, redirect may no longer be supported and links that are not 

updated to the new URL will not work. 

Removal of Grid Edit Settings from the Forms Tab and Report Builder 

In past releases, you were able to specify a form to use when Grid Editing a report for roles and individual 

reports. Many users did not use these Grid Edit settings and found them confusing.  In this release, these 

two Grid Edit settings no longer appear on the Forms tab if you are a new user or if your existing forms 

didn't use the settings.  If you had chosen a Grid Edit form setting other than "Standard" for a particular 

table’s roles or reports, you still see the Grid Edit settings on that table's Forms tab; if you change all the 

settings to "Standard", the Grid Edit settings will no longer appear on the Forms tab for that table.  

Similarly, the Grid Edit Override setting available in the Report Builder Advanced Options no longer 

appears if you are a new user or if your existing report did not use this setting.  If you had chosen Grid 

Edit override behavior other than "Standard" for a particular report, either on the Forms tab or in Report 



Builder, you still see the Grid Edit Override setting in Report Builder for that report.  If you change the 

setting to "Standard", the Grid Edit Override setting will no longer appear in Report Builder for that report. 

Quickly Request Permission to Create Applications  

Users can now quickly request permission to create applications. If you attempt to create an application, 

and do not have permission, the resulting page has a button you can use to send an email to your billing 

account administrator requesting permission. When the administrator grants permission, you now receive 

an email informing you of this fact. 

Mobile QuickBase Improvements 

In January, we released a view-only preview of mobile QuickBase.   We're continuing to develop 

functionality for mobile QuickBase, and in this release we've added: 

• The ability to delete records. 

• Buttons to add and edit records that more seamlessly give you the option to add or edit the 

record in the full site. We're working on the ability add and edit records within the mobile site for 

a future release. 

• The ability to choose whether to sign in to the full site or mobile site on the sign-in page. This 

setting is persistent for each device it is set on. 

• Prev, Next, and Up navigation in reports to easily browse records (shown below). 

 

To preview our mobile site, simply sign in to QuickBase on your mobile browser.  



We'd appreciate your feedback on the mobile site.  You can send us your suggestions and comments by 

selecting Feedback from the mobile menu. 

Submit Feedback on QuickBase Online Help 

You can now click the Comment on this page link at the bottom of any online help page to send us 

feedback on that page.  We look forward to hearing from you. 

 

  



What’s Fixed in QuickBase?  

We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 

QuickBase releases include bug fixes from previous releases.) 

Issue Description 

QBE000439 The email notification Notify Whom setting did not display for application 

administrators if the original application owner no longer had access to the 

application. This issue has been resolved. 

QBE005007 You were able to add a master record with a duplicate key field if both the master 

table's key field was set to a text field with a default value and there was a report 

link field in the master/detail relationship that was set to display on forms as an 

editable embedded grid edit report. This issue has been resolved. 

QBE005205 When you imported from a file, QuickBase did not recognize Text - Multiple Choice, 

Email Address, or URL field types and defaulted to Text. This issue has been 

resolved. 

QBE005292 When you added relationships while creating an application from scratch, the proxy 

field and lookup fields were not automatically created.  This has been resolved. 

QBE005693 When you added a record containing an append only field with a default value and 

changed the value for that field, both the default value and new value were saved. 

This issue has been resolved. 

QBE005697 If an application manager had permissions in two roles and cloned the application, 

the application manager only had one role (whichever had higher priority) in the 

cloned application. This issue has been resolved. 

QBE005701 The email notification Notify Whom setting was not updated if it was set to a 

"specific set of users" that included a field maker and the name of that field 

changed. As a result, the email was not sent to the user(s) listed in the field. This 

issue has been resolved. 



QBE005721 When you converted a field to a table, the converted field was not added to the new 

table's forms, and the reference proxy field for the new table did not work from the 

related tables' forms. This issue has been resolved. 

QBE005769 When a User or List - User field was used in an email notification, the Usage tab for 

this field did not include all of the places where the field was used in the notification. 

This issue has been resolved. 

QBE005780 In the January 2012 release, we implemented a fix to prevent duplicate fields from 

being added to a form. However, customers often use duplicated non-data entry 

field types, including formulas, report links, iCalendar, vCard and built-in fields.  This 

issue has been resolved; in Form Builder, fields that have not yet been used appear 

in black, fields that are used on the form and can be used again appear in blue, and 

fields that are on the form and cannot be used again appear in gray. 

QBE005790 (Introduced in the January 2012 release) When viewing a form, the Email button at 

the bottom of the form did not work. This issue has been resolved. 

  



March 2012 Release Notes [return to top] 

In our March 11 QuickBase release, we continued to improve the QuickBase UI and added the option to 

send email notifications from a user in a specific field.  See the sections below for further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The March release introduces the following new features: 

• New Look for the My QuickBase Page 

• Send Email Notifications from a User Listed in a Specified Field 

• Improvements to the Customize > Table > Permissions Tab 

• Return of Grid Edit Settings on the Customize > Table > Forms Tab 

 
New Look for the My QuickBase Page 

We have made several changes to the My QuickBase page to help you quickly find your applications and 

create new applications from templates. These changes include: 

• New icons for applications and templates when you select Display > Icons 

•  An application in which you are the manager 

•  An application that you haven't used yet, such as an application that has been newly 

shared with you by another QuickBase user. 

•  All other applications that you can access 

http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-march-2012-9#new
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•  Application template 

• The sections that used to appear on the left side of the page (including Admin, Get Started, Ask 

an Expert, and QuickBase News sections) moved to the right side of the page. 

 

Send Email Notifications from a User Listed in a Specific Field 

You can now send email notifications from a user listed in a specific field on a changed record, if you have 

set the notification to be triggered on single-record operations only and have registered your email 

domain with QuickBase.  The user in the field must be in the company's email domain.  

 



QuickBase sends the notification from the application manager’s email address instead if the field is 

empty, or if the user in the field is not a Registered QuickBase user in the company's email domain with 

permission to access the record's table. In these cases, a copy of the notification is also sent to the 

application manager. 

Improvements to the Customize > Table > Permissions Tab 

In our last release, we gave most of the tabs you use to customize your tables a makeover as part of our 

ongoing effort to make the QuickBase UI more intuitive.  In this release, we are continuing to improve the 

look of the customize table tabs by releasing updates to the Permissions tab.  Access this tab by 

selecting Customize > Tables from the menu bar on any application page.  

 

 

You'll find the following changes on the Permissions tab, in addition to the new look: 

• The Fields column for Custom Field Access no longer appears on the tab, because this column 

supplied information only and did not allow you to set custom field access. 

• We changed the name of the Full Admin setting to Edit Field Properties to make the setting 

title more descriptive. 

Return of Grid Edit Settings on the Customize > Table > Forms Tab 

We're listening!  In our February 2012 release, we removed the Grid Edit form settings for roles and 

reports from the Customize > Tables > Forms tab.  We heard from several customers that these settings 

were useful, and in this release, we have returned these two Grid Edit form settings to the Forms tab. 



 

 
What’s Fixed in QuickBase?  

We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 

QuickBase releases include bug fixes from previous releases.) 

General Issues 

Issue Description 

QBE005249 When using the GenAddRecordForm API call, passing in a User field or a List - 

User field value using email address or screen name did not work. The issue has 

been resolved. 

QBE005710, 

QBE005773 

If you had more tables than could fit in the Table bar on one screen, the Table 

menu displayed incorrectly for the last Table in the bar, and the Table bar 

displayed incorrectly.  These issues have been resolved. 

QBE005748 In a form, if you right-clicked on a text field and selected "Edit the field 

properties", you received an error message, unless there was another field on the 

same row.  This issue has been resolved. 

QBE005754 If you selected to display icons on the My QuickBase page, the Tools menu 

included the "Edit Categories" option, even though the Icon view does not include 



category information.  This issue has been resolved; the option has been 

removed from the Tools menu in Icon view.  

QBE005731, 

QBE005756 

In a form, if you right-clicked on a field directly above the first column of an 

embedded report, the field menu was hidden by the embedded report.  This issue 

has been resolved. 

QBE005793 The link to Application Properties in the Application Site Map did not go to the 

correct location.  This issue has been resolved; the link now opens the Customize 

> Application > Settings tab. 

QBE005796 If you added a relationship while creating an application from scratch, a duplicate 

reference field was created as a reference proxy on the details table. This issue 

has been resolved. 

QBE005831 The online help for the Test as Role feature contained incorrect information 

regarding how the feature behaves when the user is part of a group.  This online 

help has been updated with the correct information. 

  
Customize > Table Tab Issues 

The following issues were resolved on the table customization Fields, Relationships, Forms, Reports, 

Emails, and Properties tabs. 

Issue Description 

QBE005811, 

QBE005833, 

QBE005837, 

We resolved several general issues for the Customize > Table tabs, including: 

• When you hovered over items with tooltips, the items would move slightly. 

• The checkboxes on the Fields, Reports, and Email tabs were misaligned. 

• There also was no visual indicator for newly added items on the Fields, 

Relationships, Forms, and Emails tabs. 

QBE005802, 

QBE005804, 

QBE005806, 

We resolved several issues on the Fields tab, including: 

• The checkboxes were not aligned properly if you filtered the fields by searching. 



QBE005812, 

QBE005819, 

QBE005820, 

QBE005832, 

QBE005836 

• If you added a new field, the tab did not scroll to the newly added field.  

• The Info column did not indicate if a field was unique. 

• The Fields table header row did not scroll correctly when you scrolled down and 

to the right. 

• The cursor did not remain active in the Search field after a search completed. 

• The Delete button would appear enabled or disabled based on whether the last 

field selected could be deleted. This issue has been resolved; the button is now 

enabled if any selected fields can be deleted, and disabled if none of the selected 

fields can be deleted. 

• (Internet Explorer versions 7 and 8) The cursor should change to an arrow when 

hovering over a checkbox. 

• (Introduced in the February 2012 release) In a Sandbox application, you could 

reorder fields.  You also could not delete duplicate fields in a Sandbox 

application. 

QBE005805 The Forms & Roles and the Form Usage links in the Application Site Map should 

be combined into a single "Customize Forms" link that opens the Forms 

tab.  This issue has been resolved. 

QBE005817 The Delete button was always enabled on the Reports tab, even if you had only 

reports that could not be deleted.  This issue has been resolved; the Delete 

button is only enabled if the report list contains reports that can be deleted. 

QBE001484, 

QBE005786, 

QBE005814 

We resolved several issues on the Properties tab, including: 

• The Suppress edit button in reports option was not functional and should not 

appear on the tab. 

• The Identifying Records section was not open automatically on the tab if you 

navigated to the tab by selecting Change Record Picker Fields from the 

Reports tab More menu. 



• If you opened the Identifying Records section and/or the Advanced 

Properties section on the tab, navigated away from the tab, and then navigated 

back to the Properties tab, the sections were closed. 

  



April 2012 Release Notes [return to top] 

In our April 22 QuickBase release, we continued to improve the QuickBase UI and mobile site. See the 

sections below for further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The April release introduces the following new features: 

• Mobile QuickBase Improvements 

• Improvements to the My QuickBase Page 

 
Mobile QuickBase Improvements 

In January, we released a view-only preview of mobile QuickBase. We're continuing to develop 

functionality for mobile QuickBase, and in this release we've added: 

• The ability to add and edit records directly in the mobile site. 

• An improved look and feel for the My QuickBase Apps page. 

The mobile QuickBase site now allows adding and editing records from the mobile site. You can add 

records from any report, or directly from the Add New section of the menu: 

http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-april-2012-10#new
http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-april-2012-10#fixed
http://quickbase.uservoice.com/
http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-april-2012-10#mobile
http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-april-2012-10#myQB


 

 

Note: Form rules are not supported on the mobile site; you will have to access the full site to use forms 

that have form rules. All other dynamic field updating (such as that done in conditional dropdowns and 

formulas) is supported fully. 

The mobile My QuickBase Apps page has been given a new look: 



 

Each application now has an application type indicator: 

•  You manage this application. 

•  You haven't used this application yet (for example, it has been newly shared with you by 

another QuickBase user). 

•  This is an application template. 

An application icon with no indicator means that you have used this application, but you are not the 

application manager. 

As always, we'd appreciate your feedback on the mobile site.  You can send us your suggestions and 

comments by selecting Feedback from the mobile menu.  

 



Improvements to the My QuickBase Page 

In this release, we continued the work of improving the My QuickBase page. 

• The application list shown in Details view has been updated: 

• Application indicators are displayed to show the application type: apps managed by you ( ), 

apps you have used but do not manage ( ), new apps shared with you ( ), and templates  

( ). 

• A new column was added on the right side of the list with controls to remove an application from 

the list and delete an application. 

• The Search my apps... control filters the applications shown by app name. 

• The Display dropdown used to choose Icons or Details display has been replaced by an 

Icons/Details toggle control. 

• The Tools dropdown has been removed. 

• Search for an application has been replaced by the Adv. Search link above the applications. 

• Flags are no longer displayed, so the Clear flags command has been removed. 

• Editing categories is now available via right-click on an application in Details display. 

• The Show dropdown has been replaced by a filter control to the right of the Icons/Details toggle 

control. 

• Adding and editing categories is treated differently with this release: 

• Right-click an app to add or remove a category for that app. 

• Edit the list of categories assigned to apps using the Edit Categories command available via 

right-click on the app. Pre-generating a list of categories using the Edit Categories command is no 

longer supported. 

• The right-side content shown on this page has been updated and reorganized. 

The image below shows the new Details view of the My QuickBase page. 



 

What’s Fixed in QuickBase?  

We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 

QuickBase releases include bug fixes from previous releases.) 

General Issues Fixed 

 Issue Description 

 QBE003887 Choosing a field name with multiple consecutive spaces from the field list 
when constructing a formula would cause a formula error. This issue has 
been resolved. 

 QBE004664 When you viewed or edited a record in a non-administrator role, the table 
menu would not display tables that had View Records set to Custom Rule 
and Modify Records set to None for that role. This issue has been resolved. 

 QBE004743 Typing a date into a date field without spaces would cause the year portion 
of the date to be set to 2020. This issue has been resolved. 

 QBE005807 The mobile browser's address bar was only partially hidden when the 
mobile sign-in page loaded on iPhone 4/4S. This issue has been resolved. 

 QBE005809 Clicking the Customize this Report link before a report had completely 
loaded produced an "Unknown Report" error. This issue has been resolved. 

 QBE005844 When a report containing a Copy this <record> button was embedded on a 
dashboard, and you clicked the button, QuickBase displayed a time limit 
error message. This issue has been resolved. 

 QBE005864 Clicking a link in the Get Started panel on an application dashboard before 
the page had completely loaded produced intermittent errors. This issue 
has been resolved. 

 QBE005884 Creating an application from scratch using the Spreadsheet method caused 
the data for all fields to appear in the first field. This issue has been 
resolved. 

 QBE005900 If an administrator opened a user's personal email subscription and saved 
it, the Deliver To field would change to "Me" (that is, the administrator), 
and the subscription would no longer appear in the user's list of Personal 
Automated Emails. This issue has been resolved. 



 QBE005934 The context-sensitive help dialog shown for the application setting 'Disallow 
the "All Users in this Application" selection in the User Picker' did not 
mention that users granted "Full Administration" permissions are not 
affected by this setting. This issue has been resolved. 

   
Customize > Table - Issues Fixed 

The following issues involving the Customize > Table tabs were resolved. 

 Issue Description 

 QBE005749 In the dialog used to create a new table, pressing the Enter key to create 
the table did not work. This issue has been resolved. 

 QBE005827 When navigating the QuickBase interface using the Tab key, the focus 
did not move beyond the last table in the table bar. This issue has been 
resolved. 

 QBE005881 Accessing the Forms tab in Internet Explorer 9 over a slow network 
connection showed extraneous boxes before the list of forms loads. This 
issue has been resolved. 

 QBE005893 HTML entities in field names were incorrectly rendered on the Fields 
tab. This issue has been resolved. 

   
My QuickBase Page - Issues Fixed 

The following issues involving the My QuickBase page were resolved with this release. 

 Issue Description 

 QBE002021 In Details display, if you selected a category (with no applications assigned 
to it) from the Show dropdown, then switched to Icons display and 
removed all categories, and then returned to Details display, no applications 
appeared in the list because the category filter was still in effect.  This issue 
has been resolved; categories with no applications are automatically 
deleted. 

 QBE004903 If you removed an application from the list in the Details display, the 
application still appeared in the Icons display. This issue has been resolved. 

 QBE005680 When you deleted an application from the My QuickBase page, the 
application name did not appear in the delete confirmation message if you 
had previously removed the application and added it back to the My 
QuickBase page. This issue has been resolved. 

 QBE005758 If you had chosen to view applications in a specific category from the Show 
dropdown and then renamed that category, the Show dropdown did not 
update to display the new category name, and no applications appeared on 
the My QuickBase page.  This issue has been resolved. 



 QBE005861 If you opened the Tools menu, and then hovered your mouse over the 
Display menu, the Display menu did not open correctly.  This issue has been 
resolved; the Tools menu has been replaced by a search field, and the 
Display options now appear as buttons on the page.  

 QBE005863, 
QBE005888 

If you hovered your mouse over certain applications in the Icons display, the 
hover text included HTML tags. This issue has been resolved. 

 QBE005887, 
QBE005890 

In Firefox, if you hovered your mouse over applications with multi-line 
descriptions in the Icons display, the application description in the hover 
text was truncated after the first line and HTML tags appeared. This issue 
has been resolved; application descriptions are now truncated after three 
lines in the hover text.  

 QBE005923 In certain cases, when users requested application create permission, the 
request was being sent to account managers for accounts to which the 
users had no explicit access to any applications.  This issue has been 
resolved; QuickBase now offers to send the request only to accounts where 
the user has explicit access individually or as part of a group. 

  



May 2012 Release Notes [return to top] 

In our May 20 QuickBase release, we continued to improve the QuickBase UI.  See the sections below for 

further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The May release introduces the following new features: 

• Improvements to the Customize > Application tabs 

• Improvements to the Customize > Roles tabs 

• Improvements to the My QuickBase page 

 

Improvements to the Customize > Application tabs 

General: 

• The Settings tab has been renamed to Properties, and moved to the end of the tab row. 

• The Misc. tab has been renamed to Management. 

• The Developer tab has been renamed to Sandbox. 
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http://quickbase.intuit.com/developer/knowledge-base/quickbase-release-notes-may-2012-11#custrole
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Tables tab: 

 

• The list of tables is now filterable; type into the Search tables box to show only those tables 

with the search term in their names. 

• The Create a new Table link was replaced by a New Table button. 

• The Reorder the Tables link was removed; tables can be reordered by dragging and dropping 

them into the desired order. You can select multiple tables, then drag them all to another location 

in the table list. 

• Columns are now sortable; when you click to sort, a message is displayed to remind you that the 

tables are no longer in table order. Click Return to table list order to put the tables back into 

the order you specified. 

• Table names in the list of tables are now links; click a table name to edit that table. 

• The Relationships column in the list of tables is renamed Related to. 

• The links in the Fields and Relationships columns have been removed; click a table name to 

edit the table. 

• The Delete button was replaced by a Delete icon. 

• The More > Expel this table option was replaced by a Move this table to a new app icon. 



Roles tab: 

 

• The list of roles is now filterable; type into the Search roles box to show only those roles with 

the search term in their names. 

• The Create a new Role link was replaced by a New Role button. 

• The Reorder Roles link was removed; roles can be reordered by dragging and dropping them 

into the desired order. 

• The Roles/Reports Matrix link was renamed to Set Role access to Reports. 

• Multiple roles can be deleted at once; click the checkbox to the left of the roles you want to delete 

and click the Delete button. 

• Role names in the list of roles are now links; click a role name to edit that role. 

• The column with Permissions links in the list of roles now contains the App-level permissions 

granted to that role. The links to the Customize > Roles > Permissions tab were removed; 

click a role to edit its permissions. 

• The column with Edit Home Page links in the list of roles now contains the name of the home 

page for each role. Those names are links; click the link to edit the role's home page. 

• The column with Hide/Show Tables links in the list of roles has been removed. Click the role 

name to edit the User Interface settings for that role. 

• The More > Delete this role option was replaced by a Delete icon. 

• The More > Copy this role option was replaced by a Copy icon. 

• The More > Rename option was removed; click the role name to edit its properties. 

• The More > Show/hide reports option was removed; use the Set Role access to 

Reports link to set which reports are shown/hidden for this role. 



• The More > Select a home page link was removed; click the role name to edit the User 

Interface settings for that role. 

Pages tab: 

 

• The list of pages is now filterable; type into the Search pages box to show only those pages with 

the search term in their names. 

• The Create a new Page link was replaced by a New page button. 

• The Edit link beside each page was removed. Page names in the list of pages are now links; click 

a page name to edit that page. 

• The Usage column in the list of pages was split into two columns: Specified Home Page 

for and Default Home Page for. 

• The Delete button was replaced by a Delete icon. 

• The More > Copy this page option was replaced by a Copy icon. 

• The More > Preview this page was replaced by a Preview icon. 

• The More > Make this page the default home page was replaced by a Set as Default Home 

Page button. Select a page and click the button to make it the default home page. 

• Multiple pages can be deleted at once; click the checkbox to the left of the pages you want to 

delete and click the Delete button. 



Variables tab: 

 

• The list of variables is now filterable; type into the Search variables box to show only those 

variables with the search term in their names. 

• The Create a new variable link was replaced by a New Variable button. 

• The Edit link beside each variable was removed. Variable names are now links; click a variable 

name to edit that variable. 

• The Delete button was replaced by a Delete icon. 

• Multiple variables can be deleted at once; click the checkbox to the left of the variables you want 

to delete and click the Delete button. 

Misc. tab: 

• The tab has been renamed to Management. 

• The formatting, description, and ordering of the options on the tab have changed. 

• Developer tab: 

• The tab has been renamed to Sandbox. 

  



Settings tab: 

 

• The tab has been renamed to Properties. 

• This tab now has five "foldable" sections rather than tabs on the left. 

• The Save Changes button has been renamed to Save. 

Improvements to the Customize > Roles tabs 
 
General: 

• The Properties tab has moved to end of tab row. 

• User changes to Permissions and User Interface tabs now take effect immediately (previously 

you were required to save them with the Save button before they took effect). 

• When you create a new role, you can now enter a role description as well as a name. 

  



Permissions tab changes: 

 

• The Application-Level Permission heading has been changed to App Access. 

• The application-level permission of None was replaced by a Disable access to app for users 

with this role checkbox, to reflect the common usage of using None to disable access while 

configuring roles. 

• The table name headings and permissions that were listed vertically down the tab are now 

displayed in a table. 

• View Records field appears in the View column. 

• Modify Records field appears in the Modify column. 

• Add Records field appears in the Add column. 

• Delete Records field appears in the Delete column. 

• Save Shared Reports field appears in the Save Shared Reports column. 

• Full Admin. field appears in the Edit Field Properties column. 

• Fields field appears in the Fields column. 

• The QuickBase table names are links; click to edit a table. 

• When you set the View or Modify column value to Custom Rule, a window opens to edit the 

rule. The edit link was replaced by an Edit icon; click it to modify the custom rule. 

• When you set the Fields column value to Custom Access, a dialog opens to edit field access 

permissions. The edit link was replaced by an Edit icon; click it to modify custom field access. 

• Custom field access permission names were changed. No Access was changed to None, 

and View/Modify was changed to Modify. These changes are visible on the Custom Field Access 

dialog, and in the Field Properties tab when you choose to restrict permission by role. 



  

User Interface tab changes: 

 

• The Home page field was renamed to Role home page. 

• The Reports heading was renamed to Report Display. 

• The link to select reports for the role was replaced by a Set report access link. 

• The Application Menus heading was renamed to Menu & Table Display. 

• The checkboxes used to show menus have been changed to hide menus instead, to make them 

parallel with the other actions on this tab. 

• Table headings have changed: 

• Hide Table has been changed to Hide in Menu Bar. 

• Hide Default 'Add' Button has been changed to Hide Add Button/Links. 

• Hide Multi-record Operations has been changed to Hide Multi-record Options. 

• Improvements to the My QuickBase page 

• The New Activity column indicates activity in an application since you last visited it. The flag 

icon in this column is cleared when you access the app. 

• Categories (and the New category and Edit categories commands) are now shown in a 

dropdown in the Category column. 



• The Clear category command has been removed. To clear a category from an app, choose --

None-- from the category dropdown. 

• The way in which apps are searched for using the Adv. Search option Search for text in the 

name or description of an application has been improved. Now all the words you search for 

must be either in the app name or in the app description. Also, QuickBase discards common 

words and parts of speech such as articles and prepositions before performing the search. 

 
What’s Fixed in QuickBase?  

We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 

QuickBase releases include bug fixes from previous releases.) 

Issue Description 

 QBE005253 The Dashboard showed the Reports header on the left side panel, even if all 
reports for the user's role had been hidden. This issue has been resolved. 

 QBE005857 Tables with hundreds of fields displayed slowly in Internet Explorer 7. This 
issue has been resolved. 

 QBE005904 Icons display on the My QuickBase page did not show sandboxes and 
sandboxed applications distinctively. This issue has been resolved. 

 QBE005910 In apps with only one table, attempting to set up a personal email 
notification would cause a "Table Not Found" error. This issue has been 
resolved. 

 QBE005920 When using quick search on all tables, the results report for any table did 
not show the reports toolbar on the first page of results. If more than 10 
results were returned, the user could navigate to the second page of 
results, then back, to show the toolbar. This issue has been resolved. 

 QBE005927 Users with application-level access of "Basic Access with Sharing" could not 
delete their personal reports. This issue has been resolved. 

 QBE005967 Granting users Full Administration account permissions when they didn't 
already have app create permissions did not send them an email notifying 
them that they could now create apps. This issue has been resolved. 

 QBE005968 If the user selected a security question that contained an apostrophe (') 
during registration or email verification, subsequent display of that security 
question was truncated. This issue has been resolved. 

 QBE006022 QuickBase allows email addresses as screen names, but its comparison of 
email addresses and screen names in formulas was case-sensitive, which 
caused occasional errors in Formula-Email fields. This issue has been 
resolved; comparisons involving email addresses are now case-insensitive. 



  

Mobile Issues 

Issue Description 

 DE22 The Recent Records mobile site menu option appeared even if the Recent menu 
was hidden for the user's role. This issue has been resolved. 

 DE27 Returning to a filtered report after viewing a record showed the filtered results 
but did not display the search term used. This issue has been resolved. 

 DE32 If a user’s primary role hid all tables in the table bar, the mobile site menu still 
showed the Reports option. This issue has been resolved. 

 DE33 If the user’s primary role hid the Add button for all tables, the mobile site menu 
still showed AddRecord options. This issue has been resolved. 

 DE39 If a user's role hid a table in the table bar but still allowed View permissions for 
it, that table was hidden on the Browse Reports table chooser dropdown, but in 
some cases the table's reports were still listed. This issue has been resolved. 

  



June 2012 Release Notes [return to top] 

In our June 10 QuickBase release, we continued to improve the mobile QuickBase site.  See the sections 

below for further information. 

• What's New in QuickBase? 

• What's Fixed in QuickBase? 

Do you have an idea for improving QuickBase?  You can share your suggestions by either clicking the 

orange feedback tab on the My QuickBase page, or visiting the Customer Feedback for Intuit QuickBase 

forum (http://quickbase.uservoice.com). 

What's New in QuickBase? 

The June release introduces the following enhancements: 

• Continuous Scrolling in mobile QuickBase 

• Record Picker and User Picker Enhancements in mobile QuickBase 

• Email Records and Reports from mobile QuickBase 

• Full Site Enhancements 

Continuous Scrolling 

Now you can easily navigate long lists in mobile QuickBase using continuous scrolling, which automatically 

retrieves new data as you scroll to the bottom of each page. Any area of mobile QuickBase where you 

would see a list of items, such as table reports, search results, and record picker lists, now has continuous 

scrolling. 
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Record Picker and User Picker Enhancements 

Based on user feedback, we have enhanced the user and record pickers for consistency and usability. It is 

now easier than ever to select data for reference, predecessor and User-List fields, regardless of the 

number of choices you need to navigate. Enhancements include: 

• Autofiltering 

Select the correct value from a long list of records or users quickly by typing your search text in the 

picker. The list dynamically displays the matching items, making it faster than ever to find your data. 

  

 



• Expanded display 

To help you quickly identify the appropriate item in the record pickers for reference and predecessor 

fields, we have increased the number of fields shown in the record picker to three.  

 

 

• Enhanced display of predecessor fields 

To help you easily identify the related records in predecessor fields, we display the related records on 

forms using the first record picker field value in individual tokens. 

 

 

Email Records and Reports 

You can now send email containing a link to a report or record using mobile QuickBase. The Email button 

for reports appears at the top of the screen. The Email button for records appears on the new action 

menu at the top of the screen, along with the Edit and Delete buttons. 



 

Note: On some Android-powered HTC devices, Microsoft Outlook does not make the whole link clickable 

in the email. This is a known issue in Android; 

see http://code.google.com/p/android/issues/detail?id=8023. 

Full Site Enhancements 

Item Description 

QBE005928 The first two items in the Help menu are now Support Resources and Online 
Help.  

QBE006082 Deleting an application now requires you to type YES to confirm the deletion. 

  

  

http://code.google.com/p/android/issues/detail?id=8023


What’s Fixed in QuickBase? 

We’re continuing to focus on quality and have fixed a number of bugs in this release. All QuickBase 

releases include bug fixes from previous releases. 

General Issues 

Issue Description 

 QBE003330 Inserting the User () function via the Fields & Functions dropdown caused a 
formula syntax error due to the space before the parentheses. This issue has been 
resolved. 

 QBE005753 The message shown when your account was over service plan limits contained a 
broken link. The error message has been rewritten to resolve this issue. 

 QBE005843 User dropdowns in filter criteria used case-sensitive sorting in some cases. This 
issue has been resolved.  

 QBE005898 QuickBase incorrectly showed an "outdated browser" message in Internet Explorer 
10. This issue has been resolved. 

 QBE005928 The first two items in the Help menu are now Support Resources and Online Help.  

 QBE005944 Personal email subscriptions listed on the Customize > Table > Emails tab did not 
show the recipient in either the To column or the hover popup. This issue has been 
resolved. 

 QBE005959 Email notifications sent to users in a List - User field contained links to an incorrect 
number of records. This issue has been resolved.  

 QBE005972 API calls using API_DoQueryCount failed when custom permissions were set for a 
role. This issue has been resolved. 

 QBE006028 The performance bar that can be displayed by users in a QuickBase Enterprise plan 
did not display correct browser support information for certain recent browsers. 
This issue has been resolved. 

 QBE006042 (mobile) When a user adds a record, information from the previously-added 
record appears in the form. This issue has been resolved. 

 QBE006047 (mobile) When a required Text - Multiple-choice field was set to display as radio 
buttons, it still showed the "none of the above" option. This issue has been 
resolved. 

 QBE006054 The Contact Us link was partially obscured in the Show Get Started dashboard 
content. This issue has been resolved. 

 QBE006074 When attempting to set Modify permissions for a table to when user is Record 
Owner, the interface displays the incorrect field if there are User fields in the table 
with field IDs in the 40-49 range. This issue has been resolved. 

 

 
 
 
 
 
 
 



September 2012 Release Notes [return to top] 

We've been working hard all summer, and in our September 30 QuickBase release, we will be 
introducing changes to reporting (both using and creating reports), to field properties, to user 

management, and a handful of other areas. 
 
 

What's New in QuickBase? 
 
The September release introduces changes to the following areas: 
 
• Sign In page on www.quickbase.com 
• Mobile QuickBase 

• Manage Users page 
• Share with a New User dialog 
• Creating a Relationship 
• Add Fields dialog 
• Field Properties 
• Roles & Reports Matrix 
• New Table dialog 

• Using Reports 
• Creating a Report 
 
Due to the scope of the changes, we've made the detailed release notes downloadable in PDF format. 
 
Note: If you are experiencing issues following our September 30 release we suggest that you clear 

your browser cache. For detailed instructions on how to clear your cache please visit this article. 

 

What’s Fixed in QuickBase?  
 
We’re continuing to focus on quality and have fixed a number of bugs in this release. (As always, all 
QuickBase releases include bug fixes from previous releases.) 
 

Issue ID Description 

QBE005631 
(Chrome/Safari/Firefox) Dragging and dropping a text section when editing a 
dashboard caused the text to disappear. This issue has been resolved. 

QBE005783 
Certain dialogs shown when editing email notifications did not properly display the 
buttons at the bottom of the dialog. This issue has been resolved. 

QBE005785 
If a table report that showed only a summary report was added to a dashboard, the 
report header did not display correctly. This issue has been resolved. 

QBE005870 
The hover text that shows reference field information for relationships was cut off if 
the reference field name was very long. This issue has been resolved. 

QBE005883 

When the user attempted to save a dashboard that didn’t have a Page Name, 
choosing Go back to the previous page on the error dialog would lose all edits made 
to the dashboard. This issue has been resolved. 

QBE005924 
Extremely long formulas with syntax errors caused the formula syntax error dialog 
to display incorrectly. This issue has been resolved. 

QBE005929 
(Firefox only) The editor did not properly expand to fill the width of the browser 
window when Editing a Rich Text page. This issue has been resolved. 



QBE005946 

In some versions of Internet Explorer, displaying the list of Emails as a user with 
admin permissions caused the table to render incorrectly. This issue has been 
resolved. 

QBE006124,  
The Tables tab displayed by Customize > Application did not render properly if the 
app contained disabled relationships. This issue has been resolved. 

QBE006141  

QBE006134 

When customizing the Brand bar, leaving the left or right element blank caused the 
default text (Enter text or an image’s Web address) to appear. This issue has been 
resolved. 

QBE006169 
(Chrome/Firefox) In some cases, attempting to switch to another table while 
customizing fields resulted in an error message. This issue has been resolved. 

QBE006483 Two misspelled words were corrected in the Performance bar. 

QBE006710 

Attempting to delete a record with unsaved changes produced an “Unsaved 
changes” error dialog after the deletion had already been confirmed. This issue has 
been resolved. 

QBE006960 
(Enterprise) Some realm users did not appear in the realm directory. This issue has 
been resolved. 

QBE006978 
Some trial users who have not yet verified their email address could not access the 
list of QuickBase templates. This issue has been resolved. 

 
 
 
 

 
 

 
 
 
 
 
 
 

 
 
 
 
 
 

 

 
 
 
 
 
 

 
 
 
 
 
 



November 2012 Release Notes [return to top] 

This page describes our November 18 Quick Base release. 
 
What's New in QuickBase? 
The November release introduces the following enhancements: 
 

Default roles 
 
Email owner visibility 
 
Account usage visibility 
 
Mobile reports changes 

 
Report Builder enhancements 
 
Performance enhancements 
 

Default Roles 
You can now set a default role for an app, to allow easier app sharing. This role is used by default 

whenever a new user is added to the app, but you can always change the assigned role. 
 

 
 
Setting a default role is not required; if no role is the default, you will continue to be prompted for the 

role to use when you share an app or add a user. 
 
The default role is also used when you create a new app from scratch. The default role is set to 
Participant, which has Basic with Sharing app permissions. 
 
Certain templates have been updated to use a default role when you create a new app using that 
template. (Existing apps created from these templates are not affected.) See the table below for 

details. 

 

App name Default role 

Role already had 
"Basic with 
Sharing" 
permissions? 

Simple project manager Team Member N 

Project management portal Team Member   N  

Sales management portal  Sales Manager  Y  

Document library  Contributor  N  



Contact management portal  Management  Y  

Support knowledge base  Support Rep  N  

Non-profit management 
portal  Management  Y  

Simple contact manager  Participant  N  

Training management  Training Manager  N  

Marketing all-in-one  Participant  N  

Work order management  Maintenance Person  N  

Professional services all-in-
one  Project Manager  N  

 

 
Email Owner Visibility 
 
When showing the list of emails for a table, there are two new columns: Owner and Owner=To. These 

columns clarify who the owner for each email is, and whether the email is sent to the owner. For 
notifications, if the email owner no longer has permission to access the table, the email name is shown 
in red and the email is not sent. Increasing the visibility of email owners allows easier administration 
of emails for an app, especially in cases where the email owner no longer has access to the app. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Report Builder Enhancements 
 
The following enhancements have been made to the Columns section of the Report Builder to improve 
ease-of-use:  
 

• Added search boxes to the Report columns lists. Type into a search box to filter the fields 
shown. 

 
• Removed dividers that appeared in the Report columns lists. 

 
• Sorted fields in each list alphabetically. 

 

• Removed the <Calculated column> field from the Available list if it wasn't defined.  
 

• Renamed <Other column> to <Columns from a related table>. 

 
• Replaced the "jump" buttons on the right of the Report columns lists. These buttons now move 

the selected field up or down five places. 

 

 
 

Account Usage Visibility 
 
Account usage data is now shown in more detail on the Manage Billing Account's Summary tab to 

make it easier to keep your usage within plan limits. If your account is at 90% or more of the plan 
limit, you now have a link available to upgrade your plan. 
 

 
 
 

 



Mobile Reports Changes 
 
(QBE007228) To make mobile reports more consistent with their full-site equivalents, tapping a record 
in a report now shows the record with only the fields included in the report. Swipe the record in the 
report view, or tap the View icon in the action menu icon in the single-record view to access the 

complete record if user permissions and report settings allow.  
 
Also, the delete button has been removed from the swipe menu on the report to prevent accidental 
deleting of records. Records can still be deleted when viewing or editing them. 
 

 
 

Performance Enhancements 
 
(QBE007152, QBE007446, QBE007480, and QBE007483) In this release, we have included a number 
of performance enhancements for the My QuickBase page, grid edit reports, reports display, and 
browsers that are not emulating Chrome. 
 

What’s Fixed in QuickBase? 

 
We’re continuing to focus on quality and have fixed a number of bugs in this release. All QuickBase 
releases include bug fixes from previous releases. 
 

Issue ID Description 

QBE006130 
Variables that contained the newline character caused JavaScript errors when 
attempting to display the list of variables. This issue has been resolved. 

QBE007236 

Absorbing a table with a cross-app relationship into an app that was part of 
that relationship would prevent the absorbing app from being copied properly. 
This issue has been resolved. 



QBE007246 

Attempting to access a QuickBase URL from an email or bookmark in a realm 
using SAML for authentication sometimes redirected the user to the My 
QuickBase page after login. This issue has been resolved. 

QBE007295 
Selecting a field in the Report Builder field list by typing the field name did not 
work. (See also Report Builder Enhancements.) This issue has been resolved. 

QBE007320 
App admins could no longer see who owned a given personal report. This issue 
has been resolved. 

QBE007333 

The area used to display Sort & group items in the Report Builder was very 
wide and the buttons to add or remove an item displayed on the far right side 
of the area. This issue has been resolved. 

QBE007363 
Timeline reports would display incorrectly when they were embedded in a 
master record. This issue has been resolved. 

QBE007381 
(Chrome only) Some users were unable to use Grid Edit when they enabled 
touch events in the browser. This issue has been resolved. 

QBE007392 

(Internet Explorer 8 only) Saving a form that contained a required multiple-
choice field displayed as radio buttons resulted in a JavaScript error when that 
field did not have a value. This issue has been resolved. 

QBE007439 

(Internet Explorer 8 only) Added a warning when importing data into 
QuickBase using IE8 that the browser does not support tables with more than 
1000 fields.  

QBE007506 
When editing a record from a report, you would be returned to the top of the 
report, instead of the location of the record. This issue has been resolved. 

QBE007543 
(Internet Explorer only) Exact Forms were not displaying correctly. This issue 
has been resolved. 

QBE007581 
The Target Group column on the Manage Users page was missing. The column 
has been restored. 

 



December 2012 Release Notes [return to top] 

This page describes our December 9 QuickBase release. 

 

What's New in QuickBase? 

The December release introduces the following enhancements: 

• Email management enhancements 
• Billing history visibility 

• Mobile form rules 

 

 

 

Email Management Enhancements 

We’ve added several features that improve app managers’ and admins’ ability to manage emails in an 
app. 

• Show a single list of all emails for all tables in an app. This feature is available from the 

Manage notifications, subscriptions, & reminders link on the Management tab under Customize 
> Applications. 

• Activate or deactivate multiple emails at once using the buttons at the top of any list of 
emails. 

• Transfer ownership of any email by editing the email, then clicking the Change link that now 
appears next to the Owner field. 

 

 

 

 

 

 

 

 

 



Billing History Visibility 

QuickBase now provides a comprehensive view of your billing account activity and billing history, 
accessible from the new View Billing History link on the Manage Billing Account page. This page 
provides a comprehensive view of your billing account, including change history and billing history. 

If you pay for QuickBase by credit card, you can also obtain copies of your monthly receipts from this 
page without contacting QuickBase Support. See the sample below: 

 
 

Mobile Form Rules 

 
If you’ve ever been faced with the “form rules not supported” message when using our mobile site, 
you’ll be glad to hear that the QuickBase mobile site now supports form rules. 
 
 

 
 
 
 
 



Other Enhancements 
 

Issue Description 

QBE007314 

By default, if no field was selected, new fields were added to the top of the 
Fields list. New fields are now added just before the built-in fields, which 
appear at the bottom of the list. 

QBE007408 Copying a field now prompts the user to rename the field. 

QBE007648 

User counts shown on the Manage Billing Account pages used to include 
QuickBase Customer Support reps that had been given access to apps in the 
account. These users are no longer included in the totals displayed there. 

 

 
 
 
 
What’s Fixed in QuickBase? 
 
We’re continuing to focus on quality and have fixed a number of bugs in this release. All QuickBase 

releases include bug fixes from previous releases. 

 

Issue Description 

QBE005822 

Using an API to copy a phone number from a parent record to a child 
record made the resulting phone number appear garbled on the form 
until the record was saved. This issue has been resolved. 

QBE006079 
After copying an app, any buttons created by the CopyParentChild 
wizard still pointed to the original app. This issue has been resolved. 

QBE006096          

If a field name contained special characters copied from a Microsoft 
Office application, attempting to set custom field permissions for that 
field would fail with an error message.  This issue has been resolved. 

QBE006125 

If the Fields dropdown was set to “No access” when editing, it would 
appear as “Custom access” with all the fields set to “No access” after 
the role was saved. This issue has been resolved. 



QBE006132 
The Search box shown in List-User fields was not filtering names 
correctly when used inside a filter term. This issue has been resolved. 

QBE006174 
When attempting to set a role’s permissions for a table, the user’s 
choice was not saved. This issue has been resolved. 

QBE006782 
Application space table statistics listed in various places within 
QuickBase now use the same units. 

QBE007104, 
QBE007105 

Importing data that included many placeholder users, then attempting 
to add a new user to the app could cause a server slowdown or crash. 
This issue has been resolved. 

QBE007316 
When viewing a form, Text – Multi-line fields that are disabled and 
empty look like checkboxes. This issue has been resolved. 

QBE007364 

(Firefox only) Returning to the Fields list using the browser’s Back 
button caused the New Fields button to be disabled. This issue has 
been resolved. 

QBE007378 
On the Manage User’s page, filtering by role did not update the total to 
show the number of users in that role. This issue has been resolved. 

QBE007387 

In some cases, displaying a report after customizing prompted the user 
for a report name instead of using a default report name. This issue has 
been resolved. 

QBE007443 

Checking the Delete upon save checkbox for a file attachment removed 
the ability to see the revision history for that field. This issue has been 
resolved. 

QBE007479 

A nonfunctional New <record> option appeared on the grid edit toolbar 
even when the user’s role did not have “add record” permission for 
that table. This issue has been resolved. 

QBE007487 
Only the first page of an unsaved multi-page report displayed on the 
mobile site. This issue has been resolved. 

QBE007593 
Clicking Apply Changes after using Grid Edit on a report would sort the 
report. This issue has been resolved. 

QBE007610 
A number of display issues affecting append-only Text fields have been 
resolved. 

QBE007682 
Attempting to view a record from a report link on the mobile site 
resulted in an error message. This issue has been resolved. 

QBE007798 
Form rules used to compare User fields did not work when viewing a 
record. This issue has been resolved. 

 
 


